User's Manual for

Sabaton v1.0

DRAFT PER 2002-10-04 15:26

by Sydvest - www.sydvest.com
This manual was produced using *Doc-To-Help*® by WexTech Systems, Inc.
# Contents

1. Introduction ................................. 1
   1.1 About Sabaton ........................................ 1
   1.2 About the Manual ................................. 1
   1.3 Getting more Information ................. 2
   1.4 Installing and Uninstalling ..............................
      1.4.1 System Requirements ......................... 2
      1.4.2 Starting Setup .................................. 2
      1.4.3 Uninstalling Sabaton .......................... 3

2. Getting Started ................................. 5
   2.1 Start the Program .................................. 5
   2.2 Start a New Analysis ............................ 6
      2.2.1 Initiate a new analysis ........................ 6
      2.2.2 Analysis types ................................ 6
      2.2.3 Start analysis without modifying setup .... 7
      2.2.4 Modify analysis setup ........................ 7
   2.3 The Sabaton Program Window .................. 8
      2.3.1 Program Window Layout ...................... 8
      2.3.2 Working with the System Hierarchy ......... 10
      2.3.3 Entering Level and Component Information 12
   2.4 Overview of Sabaton Menus from an Analysis . 13
      2.4.1 The File Menu ................................ 13
      2.4.2 The Edit Menu ................................ 15
      2.4.3 The Information Menu ........................ 16
      2.4.4 The Setup Menu ................................ 16
      2.4.5 The Report Menu ................................ 18
      2.4.6 The Failure Modes Menu .................... 19
      2.4.7 The Window menu ............................. 19
      2.4.8 The Help Menu ................................ 19

3. Analysis Information .......................... 21
   3.1 Analysis Description ........................... 21
      3.1.1 Setup of Analysis Description .............. 22
   3.2 Analysis Team ....................................... 23
      3.2.1 Setup of Analysis Team ...................... 25
   3.3 Revision List ....................................... 26
      3.3.1 Setup of Revision List ...................... 28
1. Introduction

1.1 About Sabaton

Sabaton is a program for FMEA (Failure Mode and Effects Analysis) and FMECA (Failure Mode, Effects and Criticality Analysis) analysis. The FMEA/FMECA method is widely used in product and system development to reveal possible failures and to assess the potential causes and effects of these failures. The analysis typically results in improvement proposals aimed at eliminating system malfunction or to reduce the effects of the failures, and is also valuable in understanding complex system behaviour.

The Sabaton user is assumed to be familiar with the FMEA/FMECA methodology. Thus the user’s manual does not include any description of the method as such. You may, however, refer to the numerous textbooks and standards that are available. Some references to text books as well as standards are found in “List of References” on page 63, see, e.g., refs. [1] and [2].

1.2 About the Manual

Figure and dialog appearance

All figures and program dialogs in this manual are taken from Windows 2000. With Windows 9x/NT/XP the appearance may differ slightly.

Typing conventions

Throughout the guide, menu options for Sabaton appear in bold in the following form: Main menu name | menu command. E.g., to create a new analysis you must first click on the File menu and then select the New analysis command from the drop-down list. This command is then described as the File | New analysis command.
Shortcuts for menu commands may both be available through keyboard combinations and the toolbar. These shortcuts appear to the left of the text describing the menu command or operation. E.g.:

The **File | New analysis** command has a shortcut in the toolbar.

Many commands are available through a shortcut menu, activated by right-clicking on the mouse. The commands available from the shortcut menu vary depending on where the menu is activated, and offer the most useful commands for the task being conducted (these are normally chosen from the regular command menu). Some commands may, however, only be accessed from the shortcut menu.

### 1.3 Getting more Information

This user’s manual is always the first place to look for help. The User’s Manual is also available within Sabaton through the help menu and “Help”-buttons.

If you still need help, please contact your distributor or visit our Web-site:

[http://www.sydvest.com](http://www.sydvest.com)

### 1.4 Installing and Uninstalling

#### 1.4.1 System Requirements

- Windows 9x, NT, 2000 or XP
- Pentium 233 MHz processor minimum
- 64 Mb RAM minimum, 128 Mb recommended
- 50 Mb free disk space
- Available on CD

#### 1.4.2 Starting Setup

It is recommended that you close all programs running on your computer before installing.

If your Sabaton installation file is available as, e.g. a downloaded file on your file server, it may have a different name than given below. In this case follow the same
instructions, but change the name and location of the installation file.

Follow the instructions below to install:

1. Place the Sabaton installation CD in your PC’s CD-ROM drive.
   - If your CD-ROM has AutoPlay enabled, the Sabaton Setup will start automatically. In this case, skip to step 4.
2. Open the Run dialog box by opening the Start menu and choose Run.
3. Start the Sabaton Setup program by typing d:\setup (where d: is the drive containing the Sabaton CD) and press Enter.
4. The Sabaton Setup screen appears. Follow the instructions on your screen.

1.4.3 Uninstalling Sabaton

You can use the uninstall feature of Sabaton to remove the program from your system.

1. Click the Start button, select Settings, and click Control Panel. The Control Panel opens.
2. Open the Add/Remove Programs control. The Add/Remove Program Properties dialog box appears.
3. In the list of programs that can be removed, select Sabaton, then click the Add/Remove button.
4. Click Yes to confirm that you want to remove Sabaton.
2. Getting Started

2.1 Start the Program

The following dialog appears when starting Sabaton:

See “Start a New Analysis” on page 6 if you want to start a new analysis.

To open an existing analysis, either select one of the recently used analyses from the list, or select **Browse existing files...**

Note that if you started the program by double-clicking on a Sabaton file you will go directly to the program window, please see “The Sabaton Program Window” on page 8.
2.2  Start a New Analysis

2.2.1  Initiate a new analysis

A new analysis is either started from the File menu or through
the program start-up, as described in “Start the Program” on
page 5.

Select File | New analysis from the File menu to start a new
analysis.

When initiating a new analysis, the dialog below appears.

Select analysis type from the dialog, and further, select which
of the templates within the selected analysis type you prefer to
use in your analysis.

Note that you need to refresh the list of analysis templates if
you have copied new templates into your system manually
(Please refer to ????? for a description of this). Then select
the Refresh templates command from the dialog.

For comments on the Modify analysis setup check-box, see
“Start analysis without modifying setup” on page 7 and
“Modify analysis setup” on page 7.

2.2.2  Analysis types

Currently, there are two different analysis types available, the
FMEA and the FMECA:

- **FMEA forms**
  Analysis forms for performing Failure Mode and
  Effects Analysis (FMEA), i.e., without criticality
  ranking options.

- **FMECA forms**
  Analysis forms for performing Failure Mode,
Effects and Criticality Analysis (FMECA). Here, you may include columns with calculated fields in the form, as well as including a criticality/risk matrix.

Whether both analysis types are available or just the former depends on what licence you purchased.

Sabaton have some predefined analysis templates, however, you may also create your own templates, or obtain further templates from Sydvest or colleagues.

2.2.3 Start analysis without modifying setup

If you want to start an analysis without modifying the analysis setup, simply un-check the “Modify analysis setup” check-box before you press OK. In this case, you proceed to the regular Sabaton program window. Please refer to “The Sabaton Program Window” on page 8.

2.2.4 Modify analysis setup

If you want to modify the analysis setup before you start the analysis, retain the “Modify analysis setup” check-box checked, and press OK. You will now proceed to the Modify analysis setup and analysis information dialog, see below:

![Modify analysis setup dialog](image)

From the Modify analysis setup and analysis information dialog you are able to change the setup for the analysis, like system breakdown and the analysis form columns. You may
also enter analysis information, like analysis title. Please see below. Note that all information and setup can be entered and altered also during the analysis.

The commands available are:

**System and component setup**

The System and component setup command opens a dialog where you specify the hierarchical breakdown of the system as well as what information to hold for both the system levels and the components. For components, also selections for the optional failure mode library are given. Please refer to “System and Component Setup” on page 49.

**Analysis form setup**

The Analysis form setup command opens a dialog where you specify the layout of the analysis form itself, including which columns to include, their headings, etc. Also your selections for the optional risk/criticality matrix is made here, as well as the options for status codes that can be used for highlighting failure modes in the analysis. Please refer to “Analysis Form Setup” on page 53.

**Analysis description**

The Analysis description command opens a dialog where you can define the analysis title, description and similar. This is further described in “Analysis Description” on page 21.

**Analysis team**

The Analysis team opens a dialog where you can enter and manage an overview of all persons involved in the analysis. This is further described in “Analysis Team” on page 23.

**Revision list**

The Revision list command opens a dialog where you can enter and manage an overview of the revisions of the analysis. The various revisions can also be linked to the analysis team. This is further described in “Revision List” on page 26.

### 2.3 The Sabaton Program Window

#### 2.3.1 Program Window Layout

The Sabaton program window has a menu, a toolbar for menu shortcuts, two sub-windows where the actual analysis is done, a system hierarchy sub-window, and a status bar at the bottom of the window, see figure below.
External failure mode library

Note! When working with an external failure mode library, the program window will appear somewhat different. This is discussed separately, see “External Failure Mode Libraries” on page 61.

System hierarchy

In the system hierarchy sub-window (to the left), or system window for short, you construct and move around in the system hierarchy. The analysis window (to the right) displays the failure modes of the component (or lowest indenture level) selected in the system window.

“View failure modes for components”

“View failure modes for levels”

Note that you may view failure modes for several components simultaneously by selecting View failure modes for levels from the shortcut menu.

System / analysis window dividing line

Note that you may move the dividing line between the system and analysis window by clicking and dragging the divider.

Please refer to “Working with the System Hierarchy” below for further description of the system window. The section “Entering Level and Component Information” on page 12 explains how you can enter descriptive information for levels and components. “Performing the Analysis” on page 31 explains how the analysis is conducted, assuming that the system hierarchy is defined.
2.3.2 Working with the System Hierarchy

Expand / collapse system hierarchy

Expand and collapse the system hierarchy by clicking the “+” and “-” signs in the hierarchy, or select one level/component, and choose Expand or Collapse from the shortcut menu.

Example; by clicking on the “+” sign in figure below, the “LSH protection loop” level expands:

System window shortcut menu

From the shortcut menu you have several additional commands available, see figure and description below.
Note! Shortcut menu on selected level or component only

Note that you need to select the level/component you want to modify before you can activate the shortcut menu. Thus, if you right-click on a level or component different from the current, the level or component will be highlighted, but shortcut menu will not open. Simply right-click once more to activate the shortcut menu.

System window command toolbar

In the system window heading, a command toolbar is also available. These commands are selected commands from the shortcut menu, and are described below.

Add level / Add component
Select this command to add a level or component below the current level.

Components directly under higher system levels

Note! In Sabaton you may optionally add components connected to system levels higher than the next-lowest system level. This is, however, a special feature and not the normal situation.

Delete
Deletes the current level or component.

Rename…
Opens the name of the current level or component for editing.

Move up
Moves the current component or level (including sublevels/components) one step upwards.

Move down
Moves the current component or level (including sublevels/components) one step downwards.

Expand
Expands the selected level into the next indenture level.

Expand all
Expands all levels below the selected level, all the way down to the component level.

Collapse
Collapses the items of the selected level.

View failure modes for components
The analysis window have two different views. This view shows only the failure modes for the current component. You may add new failure modes (rows) to the component, in addition to editing the existing. See “Analysis window display mode” on page 32 for further details.

View failure modes for levels
This view displays an aggregated list of all failure modes for
all components below the selected level. In this view, you are not allowed to add new failure modes (even if only a single component is selected). See “Analysis window display mode” on page 32 for further details.

**Show matrix for levels and sublevels / this component**
This command is only available if a risk/criticality matrix is defined for the analysis. When selecting this command, a window opens displaying the risk/criticality matrix for the currently selected level or component. See “Working with Risk/Criticality Matrices” on page 45 for further details.

**Cut / Copy / Paste / Paste special... / Paste external**
Sabaton offers various copy & paste options. For example, the “Paste external” command lets you copy & paste between Sabaton analyses. See “Using the Copy/Paste Features” on page 37.

### 2.3.3 Entering Level and Component Information

When a component or level is selected in the system window, the upper part of the analysis window displays some descriptive fields linked to the selected component/level. These fields are user definable, although some of them are mandatory. Please refer to “System and Component Setup” on page 49 for help on defining which fields to include as well as the labels to be used for these fields. Also details about the length of the various text fields is given there.

In the figure below, a component have been selected, and the analysis have been set up with the **maximum** of the available descriptive fields.

You enter the name, description, etc. for the selected component directly in the analysis window. Observe that when you enter the component name, the name is also changed simultaneously in the system window. Observe also that the **System** and **Subsystem** fields in the figure above is a
reference to the system levels for the selected component, and these fields can not be edited when the component is selected.

When a level is selected, only the level name and (if included) the level description is displayed, along with the level names for the above levels.

The various descriptive fields for the component and level can also be included in reports, such as the System overview report (please refer to “System Overview Report” on page 58) and in the analysis reports (please refer to “Working with Report Templates” on page 57).

2.4 Overview of Sabaton Menus from an Analysis

First note that the Sabaton menu options will vary depending the active window being an analysis or a failure mode library. The description below explains the menu options available when an analysis is active.

Please refer to “Overview of Failure Mode Library Menus” on page 61 for a description of available menu commands when working with an external failure mode library.

2.4.1 The File Menu

The File menu contains common file-commands for creating, opening and printing analyses. Also available are three different “Save as” commands.
The File menu is given above, and the various commands are briefly described below.

**File | Open analysis**

Use the **File | Open analysis** command to open an existing analysis. A dialog box for selecting the analysis will be displayed.

**File | Open failure mode library**

Use the **File | Open failure mode library** to open an existing failure mode library. A dialog box for selecting the failure mode library will be displayed.

**File | New analysis**

Use the **File | New analysis** command to create a new analysis. Please refer to "Start a New Analysis" on page 6 for further information about starting a new analysis, and to “Modifying the Analysis Setup” on page 49 regarding how to modify the analysis setup.

**File | New failure mode library**

Use the **File | New failure mode library** to create a new external failure mode library. An external failure mode library is an option you have to define and manage failure mode libraries independent of analyses. These libraries can be imported into an existing analysis, and can also be updated from an ongoing analysis. Please refer to “Failure Mode Libraries” on page 61 for more information about failure mode libraries in general.

**File | Save as**

When selecting the command **File | Save as**, you may choose between the following options:

The different options works as follows:

- **Analysis with new name**
  Saves the analysis with a different file name and/or location. Note that the current analysis will remain the active analysis.

- **Analysis revision**
  Saves the analysis for archive purposes. A standard
“Save as” dialog will appear, and the suggested file name will be the existing file name post fixed with the current date and time.

- **Analysis template**
  Creates a new analysis template from the setup of the current analysis. Thus, to create new analysis templates, e.g. in order to build up your company specific templates, first modify the analysis setup for a specific analysis, and then use the File | Save as ... Analysis template command.

<table>
<thead>
<tr>
<th>Library of company specific analysis templates</th>
</tr>
</thead>
<tbody>
<tr>
<td>By using the File</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Location of analysis templates</th>
</tr>
</thead>
<tbody>
<tr>
<td>You may store the analysis templates in different locations, and switch between different template libraries. Use the Setup</td>
</tr>
</tbody>
</table>

**File | Close**

Use the File | Close command to close the current analysis.

**File | Exit**

Use the File | Exit command to exit from the Sabaton program.

### 2.4.2 The Edit Menu

The Edit menu contains common commands for editing the system hierarchy and the identified failure modes.

Please refer to “Using the Copy/Paste Features” on page 37 for a description on how to use these commands.
2.4.3 The Information Menu

The Information menu offers commands for entering and managing administrative information about the analysis.

**Analysis description**

The Information | Analysis description command opens a dialog where you can define the analysis title, description and similar. This is further described in ?? “Analysis Description” on page 21.

**Analysis team**

The Information | Analysis team opens a dialog where you can enter and manage an overview of all persons involved in the analysis. This is further described in ?? “Analysis Team” on page 23.

**Revision list**

The Information | Revision list command opens a dialog where you can enter and manage an overview of the revisions of the analysis. The various revisions can also be linked to the analysis team. This is further described in ?? “Revision List” on page 26.

2.4.4 The Setup Menu

The Setup | System and component setup command opens a dialog where you specify the hierarchical breakdown of the system as well as what information to hold for both the system levels and the components. For components, also selections for the optional failure mode library are given. Please refer to “System and Component Setup” on page 49 for further information.

**Analysis form setup**

The Setup | Analysis form setup command opens a dialog where you specify the layout of the analysis form itself, including which columns to include, their headings, etc. Also your selections for the optional risk/criticality matrix is made here, as well as the options for status codes that can be used for highlighting failure modes in the analysis. Please refer to “Analysis Form Setup” on page 53 for further information.
Sabaton settings

The last command opens the Sabaton system settings dialog. This is described below.

From the Setup | Sabaton settings... command you open the Sabaton settings dialog (see below). The system settings are stored in the Sabaton ini-file, located in the Sabaton program folder.

**Date and time formats on reports**

Specify the format of the date and time information printed on the various reports.

**Person name formatting**

Specify the format of the person names that can be included in the more “administrative” type of reports.

**Location of analysis templates**

When you start a new analysis in Sabaton, either by selecting the File | New analysis or when starting the program, you are asked to select from a list of analysis templates. The analysis
templates are stored in individual files, and the address to the template location is set in the Sabaton setting dialog.

The default analysis template location is the “Templates” folder located directly under the Sabaton program folder.

Relevant information related to analysis templates are:

- “Start a New Analysis” on page 6 gives information about starting a new analysis.
- Create new analysis templates by using the File | Save as command, see “The File Menu” on page 13.

**Company logo (on reports)**

A logo/picture is included in the “administrative” type of reports (i.e. other reports than the analysis report). The recommended size of the logo is approximately 100 pixels wide and 32 pixels high (same as the default logo, see the dialog as given above). In case you select a larger logo than 225 pixels wide and 75 pixels high, only a segment of the logo is printed on the reports. The dialog provides a preview of the selected logo/picture.

Note that the Sabaton logo is used as the default logo, as also shown in the dialog above.

### 2.4.5 The Report Menu

The Report menu contains commands for creating analysis reports as well as the other, more “administrative” type of reports. Different templates may be defined for analysis reports.

Please refer to “Preparing reports” on page 57 for further description of reports.
2.4.6 The Failure Modes Menu

The Failure Modes menu contains commands for working with the internal failure mode library, as well as import from and export to external failure mode libraries. Please refer to “Local Failure Mode Library (in Analysis)” on page 61 for a further description.

2.4.7 The Window menu

The Window menu contains standard Windows commands to arrange windows on the screen, and to toggle between open windows.

2.4.8 The Help Menu

The Help menu contains standard Windows help commands.

Note that the Help | About Sabaton... command opens a dialog where information about your licence (licensee and licence number), as well as the program version and build. This is useful information if you have questions to your Sabaton supplier.
3. Analysis Information

3.1 Analysis Description

Use the Information | Analysis description command to open the Analysis description dialog. The analysis description includes a number of information fields that describes the analysis, such as the analysis title. This information can be included in various reports, e.g. the analysis reports.

In the figure below, an example of the Analysis description dialog is shown. Note that the setup of the analysis description is user definable, and thus that the information fields and labels can vary. This is described below.

An overview of the available information fields is given below. Have in mind that the setup is user definable, whereas
the list below is the maximum number of information fields and assuming default labels. Two of the fields are mandatory, as indicated in the list. Note that also the labels for the mandatory fields can be changed.

The available information fields are:

- **Analysis title** (*mandatory*): A title may be assigned to the analysis. The title is displayed in the Sabaton program window, and also prints among others top centred on the analysis reports. **Maximum 50 characters.**

- **Comment** (*mandatory*): A free text field describing the analysis. The field may e.g. be used to describe the scope and objective of the analysis, as well as reference to drawings and limitations etc. In addition to being available online, the comment can be printed on the Analysis title page report (see “Analysis Title Page” on page 59). **Maximum 40 000 characters.**

- **Study owner**: Selected from the list of team members. Please refer to “Analysis Team” below.

- **System designer**: Also selected from the list of team members.

- **Mission**: Here you may e.g. enter a mission for the system under analysis. This can among others be included in the heading of the analysis reports. **Maximum 50 characters.**

### 3.1.1 Setup of Analysis Description

Select **Setup** from the **Analysis description** dialog to open the **Setup of analysis description** dialog. The following dialog opens:
Select which information fields to include by checking the “Incl.” column. If you want to enter a different label than the default, uncheck in the “Use default” column and enter the user definable label in the “Label” column.

The first two information fields are mandatory (indicated with grey background in the “Incl.” column), however you can specify a different label than the default also for these fields.

### 3.2 Analysis Team

Use the Information | Analysis team command to open the Analysis team dialog. The analysis team is an optional overview of persons (“team member”) involved in the analysis, e.g. participating in work meetings, persons with responsibility for e.g. follow-up of actions, the system responsible, etc.

The team members are available from drop-down lists in the analysis description (see “Analysis Description” on page 21), and you can also link team members to the analysis revision (see “Revision List” on page 26).

In the figure below, an example of the Analysis team dialog is shown. Note that the setup of the analysis team is user definable, and thus that the information fields and labels can vary. This is described below.
When you highlight a team member from the list, and select **Edit**, the **Team member** dialog appears:

An overview of the available information fields is given below. Have in mind that the setup is user definable, whereas the list below is the maximum number of information fields and assuming default labels. One of the fields is mandatory, as indicated in the list. Note that also the labels for the mandatory field can be changed.

The available information fields are:

- **First name**: First name of the team member.  
  *Maximum 50 characters.*
- **Last name** (*mandatory*): Last name of the team member.  
  *Maximum 50 characters.*
- **Initials**: The initials of the team member.  
  *Maximum 4 characters.*
- **Title**: The title of the team member. This is picked from a drop-down list. Picked from a fully user-definable drop-down list.  
  *Maximum 30 characters for each drop-down list element.*
- **Company**: The organisation where the team member is employed. Picked from a fully user-definable drop-down list.  
  *Maximum 30 characters for each drop-down list element.*
- **Expertise**: The expertise of the team member. Picked from a fully user-definable drop-down list.  
  *Maximum 30 characters for each drop-down list element.*
- **Phone**: The phone number of the team member.  
  *Maximum 30 characters.*
- **E-mail**: The e-mail address of the team member.  
  *Maximum 50 characters.*
- **Comment**: Any comment/free text.  
  *Maximum 40 000 characters.*

### 3.2.1 Setup of Analysis Team

Select **Setup** from the **Analysis team** dialog to open the **Setup of analysis team information** dialog. The following dialog opens:
Select which information fields to include by checking the “Incl.” column. If you want to enter a different label than the default, uncheck in the “Use default” column and enter the user definable label in the “Label” column.

The second information field is mandatory (indicated with grey background in the “Incl.” column), however you can specify a different label than the default also for this field.

### 3.3 Revision List

Use the **Information | Revision list** command to open the **Revision list** dialog. The revision list is an optional overview of revisions of the analysis. Note that the analysis file itself contains one version of the analysis only. Thus the revision list is intended as administrative information only, and helps you in maintaining an overview of the different revisions. You may also link team members to the various revisions, as explained below.

In the figure below, an example of the **Revision list** dialog is shown. Note that the setup of the revision list is user definable, and thus that the information fields and labels can vary. This is described below.
When you highlight a revision from the list, and select **Edit**, the Revision dialog appears:

An overview of the available information fields is given below. Have in mind that the setup is user definable, whereas the list below is the maximum number of information fields and assuming default labels. Four of the fields are mandatory,
as indicated in the list. Note that also the labels for the mandatory fields can be changed.

In addition to the information fields described below, you may also indicate which of the team members that have participated in preparing the revision in the team member list at the bottom of the Revision dialog.

The available information fields are:

- **Current revision** *(mandatory)*: A status flag that can be set for one (and only one) of the revisions in the list. The revision name for Current revision will appear in the analysis report heading.

- **Revision name** *(mandatory)*: The revision name or code. *Maximum 10 characters.*

- **Start date**: The start date of the revision.

- **Ongoing** *(mandatory)*: For the revision that is marked as Current, you may indicate that it is still ongoing, instead of giving it an end date.

- **End date** *(mandatory)*: The end date of the revision.

- **Responsible**: Selected from the list of team members. Please refer to “Analysis Team” on page 23.

- **Revision approved by**: Also selected from the list of team members.

- **Comment**: Any comment/free text to the revision. *Maximum 40 000 characters.*

### 3.3.1 Setup of Revision List

Select Setup from the Analysis description dialog to open the Setup of analysis description dialog. The following dialog opens:
Select which information fields to include by checking the “Incl.” column. If you want to enter a different label than the default, uncheck in the “Use default” column and enter the user definable label in the “Label” column.

The first two information fields are mandatory (indicated with grey background in the “Incl.” column), however you can specify a different label than the default also for these fields.
4. Performing the Analysis

4.1 General

When performing the analysis in Sabaton, you mainly work in the system and analysis sub windows. The system window, to the left in the program window, contains the system hierarchy, and the analysis window, to the right in the program window, contains the identified failure modes. See also the program window in the figure below.

Please refer to “Program Window Layout” on page 8 for a general description of the program window and “Working with the System Hierarchy” on page 10 about the system window.
4.2 The Analysis Window

4.2.1 Analysis window display mode

“View failure modes for components”

By default, the analysis window displays the failure modes for the selected component in the system hierarchy. This means that you select a component in the system window, and the identified failure modes for this component is listed in the analysis window. If a level is selected, no failure modes will be listed. This display mode is denoted **View failure modes for components**.

“View failure modes for levels”

You may also view identified failure modes for more than one component simultaneously. This is done using the **View failure modes for levels**.

You toggle between **View failure modes for components** and **View failure modes for levels** from the shortcut menu in the system window, see figure below.
Viewing failure modes for levels

When viewing failure modes for levels, and aggregated list of all failure modes for all components under the selected level is displayed. In this mode, one column is added in the analysis window, denoted “Path”, showing the level that the component is connected to. In the figure below, a level just under the top level is selected, and the analysis window shows all failure modes identified for the two components connected to this level.

<table>
<thead>
<tr>
<th>System</th>
<th>Analysis - FMECA of Liquid vessel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Liquid vessel</td>
<td>System</td>
</tr>
<tr>
<td>LSH protection loop</td>
<td>Subsystem</td>
</tr>
<tr>
<td>LSH switch</td>
<td>Component</td>
</tr>
<tr>
<td>Valve 1 (inlet)</td>
<td></td>
</tr>
<tr>
<td>Valve 2 (inlet)</td>
<td></td>
</tr>
<tr>
<td>Valve 3 (outlet)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>$</th>
<th>ID</th>
<th>Path</th>
<th>Failure Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>FM001</td>
<td>Liquid vessel LSH protection loop LSH switch</td>
<td>Fail to open</td>
</tr>
<tr>
<td>$</td>
<td>FM002</td>
<td>Liquid vessel LSH protection loop LSH switch</td>
<td>Spurious operation</td>
</tr>
<tr>
<td>$</td>
<td>FM003</td>
<td>Liquid vessel LSH protection loop Valve 1 (inlet)</td>
<td>Spurious operation</td>
</tr>
<tr>
<td>$</td>
<td>FM004</td>
<td>Liquid vessel LSH protection loop Valve 1 (inlet)</td>
<td>Fail to open</td>
</tr>
<tr>
<td>$</td>
<td>FM005</td>
<td>Liquid vessel LSH protection loop Valve 1 (inlet)</td>
<td>External leakage</td>
</tr>
</tbody>
</table>

4.2.2 Basic analysis window operations

To edit an identified failure mode, simply activate the column you want to edit by clicking or double-clicking inside the column (or cell, to be precise). If the column is a drop-down list, click once and the drop-down selection is displayed, and you make your selection. If the column is a text or numeric field, double-click to open for edit.

Escape or Ctrl+z recovers from unintentional text/number replacement

**Note!** If you click only once on a text or numeric field, and start typing, the current cell content will be replaced. Use the **Esc** button to exit from edit mode without saving. Alternatively, you may use the **Ctrl+z** command to undo the typing, and continue in edit mode. See also below about editing commands.

**Basic Commands when Editing Text or Number Fields**

When a text or number field is opened for edit as described above, you may use the standard Windows commands for copy, paste, etc. The commands are available from the shortcut menu from within the cell (cell must be opened for
edit as described above), see figure below. You may also use the keyboard shortcuts to access some of these commands, as described below.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Copy</strong></td>
<td>Use the Copy (Ctrl+c) command to copy selected text to the Windows clipboard.</td>
</tr>
<tr>
<td><strong>Cut</strong></td>
<td>Use the Cut (Ctrl+x) command to cut selected text to the Windows clipboard.</td>
</tr>
<tr>
<td><strong>Paste</strong></td>
<td>Use the Paste (Ctrl+v) command to paste the content of the Windows clipboard into the field.</td>
</tr>
<tr>
<td><strong>Undo</strong></td>
<td>Use the Undo (Ctrl+z) command to undo the last change. Note that only one step undo is available.</td>
</tr>
<tr>
<td><strong>Select all</strong></td>
<td>Use the Select All command to select all text in the cell.</td>
</tr>
<tr>
<td><strong>Exit field without saving using Esc</strong></td>
<td>If you press the Esc button while editing a text or numeric field, you exit the edit mode without saving.</td>
</tr>
<tr>
<td><strong>Copy/paste text between Windows programs</strong></td>
<td>Note that the above copy/paste commands uses the Windows clipboard. Thus, you may copy/paste text between different Windows programs using these commands.</td>
</tr>
</tbody>
</table>

**Basic Analysis Window Commands**

The basic analysis window commands are available from the shortcut menu within the analysis window, see figure and description below.
<table>
<thead>
<tr>
<th><strong>Add failure mode</strong></th>
<th>To add a failure mode use the Add failure mode command from the shortcut menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit commands</strong></td>
<td>The delete and copy/paste commands are described in “Using the Copy/Paste Features” on page 37.</td>
</tr>
<tr>
<td><strong>Adjust column width / Save layout</strong></td>
<td>The Save layout command saves the current column widths of the analysis form. The column widths are adjusted by dragging the dividers in the column headings. Note that if you adjust the column widths without saving the layout, the layout will be reset when a new level/component is selected. Note that the column widths saved with the layout will also be used when analysis reports are printed.</td>
</tr>
<tr>
<td><strong>Save view as report…</strong></td>
<td>The Save view as report... command saves the current failure mode listing to file. Available file types are, among others, Portable Document Format (PDF) and Rich Text Format (RTF).</td>
</tr>
<tr>
<td><strong>Print view…</strong></td>
<td>The Print view... command prints the current failure mode listing. It may be useful to have a print (or saving to a report file) of the current listing as a support when performing the analysis. Reports of the final analysis are better obtained using the Report function, see “Preparing reports” on page 57.</td>
</tr>
<tr>
<td><strong>Edit header</strong></td>
<td>The Edit header command lets you edit the column heading for the current column. If the column also has a main header, this can also be edited. The Edit header command is a subset of the functions available for defining the analysis form setup. Please refer to “Analysis Form Setup” on page 53 for more information about defining the analysis form.</td>
</tr>
<tr>
<td><strong>Set status (highlight failure mode)</strong></td>
<td>Use the Set status command to highlight the failure mode in different ways. The column to the left of the ID, “S”, shows the selected status code, and the background colour of the failure mode row may vary depending on the setup of the status codes. You may also easily sort failure modes by status as described below. To activate the Set status command, first mark the failure mode row by clicking to the left of the failure mode row as indicated in the figure below. Multiple failure modes can be selected by clicking on the first failure mode and by moving the cursor over the other failure modes while keeping the mouse button pressed down.</td>
</tr>
</tbody>
</table>
When one or multiple failure modes are marked, access the Set status command from the shortcut menu, and select the status code from the list, see figure below.

The status codes are user definable as a part of the analysis form setup, see “Analysis Form Setup” on page 53. There are totally ten different status codes available, of which the two indicated will always be activated (although the label of these may also be changed). See the reference above for further description.

**Sort failure modes**

By clicking once on a column heading, the failure mode listing is sorted descending by this field. Clicking once more on the same column heading sorts ascending. This is especially useful when a long failure mode listing is viewed, e.g. using View failure modes for levels. Have also in mind that the current listing can be printed or saved to file (see above).

**Adjust height of failure mode row**

Note that the height of the failure mode row is not adjusted automatically. This means that the text in a cell may not be visible, depending on the row height. The row height is adjusted by dragging the row divider at the bottom of the failure mode, see below.
The adjusted row heights are stored automatically and individually per failure mode, and the row heights will also be used when printing analysis reports.

### 4.3 Using the Copy/Paste Features

#### Marking system hierarchy elements for editing

To select elements from the system hierarchy for editing (i.e. copy, cut or delete), simply make them active by clicking on them. Note that only one element at a time can be selected.

#### Marking failure modes for editing

To select a failure mode, mark it by clicking to the left of the failure mode row as indicated in the figure below. A range of failure modes can be selected by clicking on the first failure mode and by moving the cursor over the other failure modes while keeping the mouse button pressed down.

<table>
<thead>
<tr>
<th>S</th>
<th>ID</th>
<th>Failure Mode</th>
<th>Failure Effect</th>
<th>Fault</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FM001</td>
<td>Fail to operate</td>
<td>VI does not close, the liquid level in the tank may rise to very high level</td>
<td>Failure to rise</td>
</tr>
<tr>
<td></td>
<td>FM002</td>
<td>Spurious operation</td>
<td>VI closes, and liquid flush stops</td>
<td>Spurious high</td>
</tr>
</tbody>
</table>

#### 4.3.1 Edit | Cut

Use the **Edit | Cut** command to cut the selected level, component or failure modes to the internal Sabaton clipboard. Observe that the status bar at the bottom of the program window displays the content of the Sabaton clipboard, see figure below.
4.3.2 Edit | Copy

Use the Edit | Copy command to copy the selected level, component or failure modes to the internal Sabaton clipboard. Also here, the content of the Sabaton clipboard is displayed on the status bar, see figure below.

Copied failure modes: FM003, FM004, FM005

4.3.3 Edit | Paste

The Edit | Paste command works different depending on if it is failure modes or system hierarchy elements that have been put on the Sabaton clipboard, see below.

**Pasting Failure Modes**

If one or more individual failure modes have been put on the Sabaton clipboard, select the component where you want the failure modes to be pasted, and make the analysis window active by clicking somewhere inside it. Now, applying the Edit | Paste command (or select it from the shortcut menu), a copy of the clipboard content is pasted as new failure modes on the current component.

Note that the status code of the copied failure modes will be set to “9”, and the background colour of the failure mode row is set to yellow, see above. The colour background for the various status codes can be altered, thus for a specific analysis the colour background may be different than above.

Please refer to “Analysis Form Setup” on page 53 for information about how to define status codes.

**Pasting System Hierarchy Elements**

To paste a level or component, you must first select a valid level to paste into (under). Valid level means that it must be allowed to add the clipboard content below the selected level. As an example, a component may be pasted into any selected level, however a sublevel can only be pasted into a level.
higher up in the hierarchy. This is controlled by Sabaton, and the Paste command is available only if a paste is allowed.

Now, selecting the Paste command, a copy of the system hierarchy of the sub tree will be pasted from the clipboard into the current level. All names of levels/components will be prefixed with “Copy of …”. Note that only the system hierarchy of the sub tree will be pasted. That is, even if a component have identified failure modes, these failure modes are not included in the paste. Please see “Edit | Paste special…” below on how to include failure modes when pasting.

4.3.4 Edit | Paste special…

The Edit | Paste special… command works only on system hierarchy elements, and is used when you want to include e.g. the failure modes of components in the paste operation. The same restriction as to selecting a valid level to paste into as was described for the Edit | Paste command applies, see “Edit | Paste” above.

Using the Edit | Paste special… command, the following dialog will open:

From the dialog, you can tailor the paste operation, and among others select that you want to include also the identified failure modes in the paste operation. Note also that you may control the names of the levels/components.

Note also that all parameters given in the dialog are not necessarily available, as this depends on the system and component setup (see “System and Component Setup” on page 49).
4.3.5 Edit | Paste external...

Use the Edit | Paste external... command to copy and paste between Sabaton analyses. If you have placed a copy of a system hierarchy element (level or component) on the Sabaton clipboard, you may paste the clipboard content into a different analysis by opening it in a separate window (move between the open analyses using the Window commands). When you have moved to a different analysis, you will see that the status bar has added some more information about the clipboard content, see example in the figure below:

![Clipboard content example]

The Paste external command works somewhat like pasting system hierarchy elements within the same analysis, and is activated from the level where you want to paste the clipboard content into. However, when you select Paste external..., two consecutive dialogs open to let you specify how the paste should be performed.

In the first dialog (see figure below), you specify what information to include in the paste operation, as well as if the pasted level/component names shall have a prefix.
Pressing **Next**, the second dialog opens, from where you select whether to include identified failure modes for the components, see figure and description below. Note that in the example below, the analysis form setup are identical in the source and destination analyses.
Check the “Include identified failure modes” check box if you want to include the failure modes identified for the components on the clipboard. If this is selected, you need to specify, for each column in the current analysis, the source column in the source analysis.

If the two analyses have identical setup, Sabaton presents a default selection that should represent a more or less full match. If this is not the case, Sabaton will suggest a column selection that will link fields of the same type between the two analyses.

You may alter the selections by drag the available columns in the source analysis (list in the top of dialog) and drop it into the chosen destination column (list in the bottom of the dialog). You may reset to default or remove all selections using the **Remove all column selections** and **Reset to default column selections** buttons in the dialog.
4.3.6 Edit | Delete

Use the Edit | Delete command to delete the selected level, component or failure modes. A warning will be displayed, so that you do not unintentionally delete information.

4.4 Using Failure Mode Library in the Analysis

The analysis may be set up applying failure mode libraries. This is specified in the system and component setup, see “System and Component Setup” on page 49. A general description of failure mode libraries is given in “Failure Mode Libraries” on page 61, however this section presents how to add and edit components and failure modes if a failure mode library is used.

In the figure below, a new component has been added in an analysis applying a failure mode library. Here, it is specified that the failure mode library has two levels, so that a component type must be selected for each component. This is done by selecting from the component type dropdown list in the upper part of the analysis window, see also below.

Select component type from the dropdown list, or select <add new> or <edit list> to add new/edit the current list, see figure below:
The list of component types may also be edited using the **Failure Modes | Edit local library...** command, see “Local Failure Mode Library (in Analysis)” on page 61.

You may use the **Add failure mode** command from the shortcut menu, as explained in “Basic analysis window operations” on page 33 to add failure modes. However until the component type is selected (and also the component class, if this is included in the setup), the failure mode dropdown list in the analysis will not be available.

Having selected component type and/or class, the failure mode dropdown list will be available, see example below. This will present the list of currently defined failure modes for the selected component type/class. As for the component type explained above, you may also select `<add new>` or `<edit list>` to add new/edit the current list.
The list of failure modes may also be edited using the **Failure Modes | Edit local library...** command, see “Local Failure Mode Library (in Analysis)” on page 61.

Having added a component, selected component type and/or class, added a failure mode row to the analysis, and also selected a failure mode from the dropdown list, the “Locked” check box to the right of the component type (and same for the component class if included) is checked, see figure below.

This is to indicate that you cannot change the component type due to the link to the selected failure mode. The component type selection may be reset by un-checking the “Locked” check box, however you will then get a warning that all failure mode selections also will be reset.

### 4.5 Working with Risk/Criticality Matrices

The analysis may be set up using a so-called risk or criticality matrix. This is specified in the analysis form setup, see “Analysis Form Setup” on page 53. This section presents how to work with risk/criticality matrices when performing the analysis. It is assumed that the reader has general knowledge about risk/criticality matrices, and is familiar with how to set up an analysis form with such a matrix.

When an analysis uses risk/criticality matrix, two columns in the analysis form is linked to the matrix, denoted the x- and y-axis of the matrix, respectively. These columns are dropdown list fields, with values specified in the matrix setup.

When a new failure mode row is added, the values for the x- and y-axis of the matrix are selected just as if they were a regular dropdown list field.
Show matrix

The difference between regular dropdown list fields and the matrix fields appears if you select the Show matrix command from the shortcut menu in the system window, see below:

The Show matrix command activates a window that will float over the analysis until it is closed. The window contains a view of the defined risk/criticality matrix, with the aggregated number of identified failure modes falling into the different cells of the matrix for the currently selected level or component in the system window.

That is, if a component is selected, only the identified failure modes for this component is counted, however if a level is selected, all failure modes identified for all the components below the selected level is counted.

An example is shown in the figure below, where the top level is selected. Note that the matrix window also shows for which part of the system the failure modes are counted (upper part of the window).
The risk/criticality matrix may also be included in the analysis report, please refer to “Working with Report Templates” on page 57 for more information about this.
5. Modifying the Analysis Setup

5.1 System and Component Setup

Use the Setup | System and component setup command to open the System and component setup dialog. The dialog have two tabs, System and Component.

The Setup | System and component setup command opens a dialog where you specify the hierarchical breakdown of the system as well as what information to hold for both the system levels and the components. For components, also selections for the optional failure mode library are given.

5.1.1 The System tab

In the System tab, you specify what descriptive information to hold for each level, as well as how the hierarchical breakdown of the system shall be done, see description below. In the figure below, an example of the System tab is shown.
Description for each level

You may specify whether or not to include a description field for each system level (including the components). Also the label for this field, if included, can be set.

The maximum number of characters that can be entered for the description field is __ characters. The label can be maximum __ characters.

This information field will be available in the analysis window when a level or component is selected. The description field can also be included in the System overview report (see “System Overview Report” on page 58). For components, the description field can also be included in the analysis reports, see “Working with Report Templates” on page 57.

System hierarchy setup

You may specify the number of levels to be used in the hierarchical system breakdown; from two to eight levels.
Note that, for an ongoing analysis, you are not allowed to reduce the number of levels below the number you have applied in the system.

For the selected number of levels, you can specify the label to use, or select the default label.

5.1.2 The Component tab

In the Component tab, you specify what descriptive information to hold for the components, as well as your selections for the optional failure mode library, see below. In the figure below, an example of the Component tab is shown.

![Component information](image)

**Component information**

You may specify whether or not to include various component descriptive fields. Note that the description field included on the System tab comes in addition. Similar to the System tab, also the label for the component descriptive fields can be set.

The available component descriptive fields are:
• **Identifier**: An optional identifier for the component.  
  *Maximum __ characters.*  
  *Label is maximum __ characters.*

• **Name** (*mandatory*): The component name.  
  *Maximum __ characters.*  
  *Label is maximum __ characters.*

• **Completed**: A logical field (check box in the analysis window), that you e.g. can use to indicate whether or not you have completed the analysis for the selected component.  
  *Label is maximum __ characters.*

• **Function**: A free text field that you e.g. can use to give a description of the component function.  
  *Maximum __ characters.*  
  *Label is maximum __ characters.*

The component information fields will be available in the analysis window when a component is selected (e.g. see “Entering Level and Component Information” on page 12). The fields can also be included in the System overview report (see “System Overview Report” on page 58) as well as in the analysis reports, see “Working with Report Templates” on page 57.

**Use Failure mode library**

On the **Component** tab (see dialog in figure above) you also specify whether or not to use the failure mode library. If failure mode library is selected, you may also specify the number of levels (from one to three) to use in the library breakdown, as well as the labels for these levels.

Having selected to use the failure mode library, you also need to include the failure mode field in the analysis form. This is done in the analysis form setup, please refer to “Analysis Form Setup” on page 53.

A brief introduction to how the failure mode library is used is given in “Using Failure Mode Library in the Analysis” on page 43. A more thorough description about failure mode libraries is found in “Failure Mode Libraries” on page 61.

**Restriction for ongoing analyses**

Note that, for an ongoing analysis, the failure mode library can be unselected only if the failure mode library field is not in use. If this field is in use you must therefore first change the analysis form setup, please refer to ?? “Analysis Form Setup” on page 53.
5.2 Analysis Form Setup

The Setup | Analysis form setup command opens a dialog where you specify the layout of the analysis form itself, including which columns to include, their headings, etc. Also your selections for the optional risk/criticality matrix is made here, as well as the options for status codes that can be used for highlighting failure modes in the analysis.
5.2.1 Risk/Criticality Matrix Setup
6. Preparing reports

6.1 Generally about Reports

6.2 Analysis reports

6.2.1 The Standard Report

6.2.2 Working with Report Templates
6.3 Other (administrative) reports

6.3.1 System Overview Report

6.3.2 Local Failure Mode Library Report

6.3.3 Analysis Team Report
6.3.4 Revision List Report

6.3.5 Analysis Title Page
Preparing reports User's Manual for Sabaton v1.0
7. Failure Mode Libraries

7.1 Generally about Failure Mode Libraries

7.2 Local Failure Mode Library (in Analysis)

7.3 External Failure Mode Libraries

7.4 Overview of Failure Mode Library Menus
8. References

8.1 List of References


9. Glossary of Terms

Criticality
A relative measure of the impact of a failure mode on the required function. Criticality combines the frequency or probability of occurrence and the level of severity of a failure mode.

Criticality Analysis
A procedure by which each potential failure mode is ranked according to the combined influence of its severity and frequency or probability of occurrence.

Dependability
The collective term used to describe the availability performance and its influencing factors; reliability performance, maintainability performance, and maintenance support.

Design review
A formal, documented, comprehensive, and systematic examination of a design to evaluate the design requirements and the capability of the design to meet these requirements and to identify problems and propose solutions.

End Level Effect
The impact or consequence of a failure mode on the operation, function, or status of the end-item.

Fail Safe
A design property of an item that prevents its failures being critical failures.
Failure Cause
The physical or chemical process, design defects, quality defects, part misapplication, or other processes

Failure Effect
The consequence(s) a failure mode has on the operation, function, or status of an item.

Failure Mode
The effect by which a failure is observed on the failed item.

Failure Mode and Effect Analysis (FMEA)
A procedure by which each potential failure mode in a system is analysed to determine the results or effects thereof on the system, to classify each potential failure mode according to its severity, and to recommend actions to eliminate, or compensate for, unacceptable effects.

Failure Mode, Effect and Criticality Analysis (FMECA)
An extension of the FMEA procedure to include assessment of the failure mode severity and frequency or probability of occurrence.

Failure Symptom
An identifiable physical condition by which a potential failure can be recognised.

Gradual Failure
Failure that could be anticipated by prior examination or monitoring.

Hidden Failure
A failure not evident to the crew or operator during the performance of normal duties.

Inspection
Activities such as measuring, examining, testing, and gauging one or more characteristics of a product or service and comparing these with specified requirements to determine conformity.
**Intermittent Failure**

Failure of an item for a limited period of time, after which the item restores its required function without being subjected to any external corrective action.

**Maintainability**

The ability of an item, under stated conditions of use, to be retained in, or restored to, a state in which it can perform its required functions, when maintenance is performed under stated conditions and using prescribed procedures and resources.

**Maintenance**

The combination of all technical and corresponding administrative actions, including supervision actions, intended to retain an entity in, or restore it to, a state in which it can perform its required function.

**Maintenance Support Performance**

The ability of a maintenance organisation, under given conditions, to provide upon demand, the resources required to maintain an entity, under a given maintenance policy.

**Preventive Maintenance**

The maintenance carried out at predetermined intervals or corresponding to prescribed criteria and intended to reduce the probability of failure or the performance degradation of an item.

**Quality**

The totality of features and characteristics of a product or service that bear on its ability to satisfy stated or implied needs.

**Redundancy**

In an entity the existence of more than one means for performing a required function.

**Reliability**

The ability of an item to perform a required function, under given environmental and operational conditions and for a stated period of time.
**Reliability Centred Maintenance (RCM)**

A disciplined logic or methodology used to identify preventive maintenance tasks to realize the inherent reliability of equipment at least expenditure of resources.

**Repair**

The part of corrective maintenance in which manual actions are performed on the entity.

**Required Function**

A function or combination of functions, of an entity, that is considered necessary to provide a given service.

**Risk**

Risk designates the danger that undesired events represents for humans, the environment or material values. Risk is expressed in the frequency or probability of the undesired events and their corresponding consequences.

**Safety**

Freedom from those conditions that can cause death, injury, occupational illness, or damage to or loss of equipment or property.

**Security**

Dependability with respect to the prevention of unauthorized access and/or handling of information.

**Severity**

The consequences of a failure mode as determined by the degree of injury, property damage, or system damage that could ultimately occur. Severity considers the worst potential consequence of a failure.

**Severity Classifications**

Severity classifications are assigned to provide a qualitative measure of the worst potential consequences resulting from design error or item failure.

**Single Failure Point**

A failure of an item that is not compensated for by redundancy or alternative operational procedure that results in adverse end level effects.
Sudden Failure
A failure that could not be anticipated by prior examination or monitoring.

Test Frequency
The number of tests of the same type per unit time interval; the inverse of the test interval.

Test Interval
The elapsed time between the initiation of identical tests on the same sensor, channel, and so forth.
10. Index

A
Analysis
   Form 7, 35–36, 41, 44–45, 52–53
   Setup 16, 35–36, 45, 52–53
   New 14, 17
Analysis team 22–23, 22–23, 58

F
Failure mode library 9, 13–14, 19, 43–45, 44, 45, 51–52, 43–45, 58, 61
   External 9, 13–14
   Local 19, 44, 45, 58, 61
FMEA 1, 63
FMECA 1, 6

R
Reliability 63–64
Revision list 16, 26, 59
Risk/criticality matrix 12, 45–47, 54
   Setup 54

S
Standard 14, 19, 33, 57
System and component 12, 39, 43, 49
   Setup 12, 16, 39, 43, 49